
New Site. Opens the New Site dialog, where you name and select a location for your new web site. You have the 
option to base your site on an AutoSite™ or other NetObjects Fusion template, or from a pre-existing web site, 
either local or remote, which is imported into the NetObjects Fusion format. 



Open Site. Opens a standard Windows file Open dialog box to let you locate and open an existing NetObjects 
Fusion web site (.nod) file. 



Save Site. Saves the current site to disk in NetObjects Fusion format, as a .nod file.



Save As. Opens a dialog that lets you choose a new name and/or location for the current site.



Import Section. Opens the Import Section dialog box to let you import templates (such as NetObjects' pre-defined
Page templates) or web sites (local or remote) into the current site (in Site view). 



Export Template. Opens the Select Folder dialog box which lets you save the current NetObjects Fusion web site 
as a template (.nft) file so that it can be imported into another NetObjects Fusion web site (necessary when 
developing across platforms).



Export Page. Opens a save dialog that lets you save the current page as an HTML file.



Import Section (in Site view).    Opens the Import Section dialog box to let you import templates (such as 
NetObjects' pre-defined Page templates) or web sites (local or remote) into the current site. 
Import Page (in Page view).    Imports an existing document, which may be HTML (*.htm or *.html), Text (*.txt) or 
Rich Text Format (*.rtf) files. 
Import Style (in Style view).    Opens a standard Windows file Open dialog box to let you locate NetObjects Fusion
SiteStyles (Style.ssf files) to add to your SiteStyle list (Style Gallery in Style View).    



Most Recently Used (MRU) Sites. Ordered list of the last several sites that you opened. To reopen a saved site, 
click its name on the MRU list.



Exit. Closes (and saves) the current site and exits NetObjects Fusion.



Undo. Undoes the last command or action (displayed with the menu item) to the previous state.    Multiple levels 
are possible. 



Cut. Cuts the selected element from the page and places it on the Windows clipboard. The element is then 
available for pasting to the same page or another page in your site until it is replaced on the clipboard by another 
Cut or Copy operation.



Copy. Copies the selected element and places it on the Windows clipboard. The element is then available for 
pasting to the same page or another page in your site until it is replaced on the clipboard by another Copy or Cut 
operation.



Paste. Pastes the contents of the Windows clipboard onto the current page.



Paste Special. Opens a window that lets you paste, link or embed special types of elements from the Windows 
clipboard. These special OLE (Object Linking and Embedding) elements are from other OLE-capable Windows 
applications, and are placed on the clipboard by copying them from the other application.



Delete (element). Lets you delete an element from your site. What gets deleted depends on which view you're in:
Delete Page. Removes the selected page or    pages from the site structure when in Site view.
Delete Element. Removes the selected object or objects from the page when in Page view.
Delete File Asset. Removed the selected file when in File Assets view.
Delete Link. Removes the selected link when in Link Assets view.
Delete Data Object. Removes the selected data object when in Data Object Assets view.
Delete Variable. Removes the selected variable when in Variable Assets view.



Select All. Selects all objects in the header, body, or footer of a page in Page view.



Find. Searches for specified text on a page.



Replace. Searches for and replaces specified text or formatting in the active document.



Delete (element). Lets you delete an element from your site. What gets deleted depends on which view you're in:
Delete Page. Removes a page from the site structure.
Remove Style. Removes the currently selected style when in Style view.



Options. 



Preferences. Opens the Preferences dialog box which has two tabs, General and Page.    General preferences 
include selecting a default browser and external HTML editor; Page preferences include setting the default page 
size and other page-level options.



Duplicate Layout. Makes a copy of a page’s layout and lists it in the Layout dropdown list.



Properties Palette. Toggles between viewing and hiding the floating Properties palette box.



Tools Palette. Toggles between viewing and hiding the floating Tools Palette.



Align Elements: Left. If more than one object is selected, this command aligns the objects to the left edge of the 
last object selected. For example, if you select three objects and then choose this item, the first two objects 
selected are repositioned so the left edges of their bounding boxes line up with the third object's left edge.



Align Elements: Right. If more than one object is selected, this command aligns the objects to the right edge of 
the last object selected. For example, if you select three objects and then choose this item, the first two objects 
selected are repositioned so the right edges of their bounding boxes line up with the third object's right edge.



Align Elements: Top. If more than one object is selected, this command aligns the objects to the top edge of the 
last object selected. For example, if you select three objects and then choose this item, the first two objects 
selected are repositioned so the top edges of their bounding boxes line up with the third object's top edge.



Align Elements: Bottom. If more than one object is selected, this command aligns the objects to the bottom edge
of the last object selected. For example, if you select three objects and then choose this item, the first two objects 
selected are repositioned so the bottom edges of their bounding boxes line up with the third object's bottom edge.



Align Elements: Center Vertically. If more than one object is selected, this command centers the objects in 
relation to the horizontal position of the last object selected. For example, if you select three objects and then 
choose this item, the first two objects selected are horizontally repositioned so they are centered in relation to the 
third object.



Align Elements: Center Horizontally. If more than one object is selected, this command centers the objects in 
relation to the vertical position of the last object selected. For example, if you select three objects and then choose 
this item, the first two objects selected are vertically repositioned so they are centered in relation to the third object.



Size Elements: Width. If more than one object is selected, this command resizes the objects to match the width 
of the last object selected. For example, if you select three objects and then choose this item, the first two objects 
selected are resized (equidistant from the outer edges inward) to match the width of the third object.



Size Elements: Height. If more than one object is selected, this command resizes the objects to match the height 
of the last object selected. For example, if you select three objects and then choose this item, the first two objects 
selected are resized (equidistant from the top and bottom edges inward) to match the height of the third object.



Size Elements: Both. If more than one object is selected, this command resizes the objects to match the height 
and width of the last object selected. For example, if you select three objects and then choose this item, the first 
two objects selected are resized (equidistant from all outer edges inward) to match the exact size of the third 
object.



Element Script. Opens the Script dialog to let you enter or insert HTML tags or scripts that are inserted into the 
raw HTML source. 



Layout Script. Opens the Script dialog to let you enter or insert scripts or HTML tags that are added to the HTML 
source of the page.



Site. Takes you to the Site view where you build, organize and edit the structure of your site. As you drag pages 
and sections to new locations in your site, NetObjects Fusion updates all the links automatically.



Style. Takes you to the Style view where you have centralized control over the look and feel of your site.



Assets. Takes you to the Assets view that lists all the files, links, data objects and variables that are associated 
with your site. This view allows for site-wide asset management.



Publish. Takes you to the Publish view where you configure your settings for staging or publishing your site to a 
local or remote web server.



Next Page. Takes you to the page that appears to the right of the current page (on the same level) in the graphical
site view.



Previous Page. Takes you to the page that appears to the left of the current page (on the same level) in the 
graphical site view.



Parent Page. Takes you to the page that appears above the current page in the graphical site view.



First Child Page. Takes you to the page that appears below the current page (the next child level) in the graphical
site view.



New (element). Lets you add a new element to your site. What gets added depends on which view you're in:
New Page. Lets you add a new page to your site when you're in Site or Page view.
New Style. Lets you create a new style when you're in Style view.
New File Asset. Lets you import a new external file such as a picture or a Java applet, when you're in File Assets 
view.
New Link. Lets you add a new external link when you're in Link Assets view.
New Data Object. Lets you create a new data object when you're in Data Object Assets view.
New Variable. Lets you add or create a new variable when you're in Variable Assets view.



Go To. Opens a dialog box that lets you perform a keyword search for items within the current view, such as an 
individual page in Site view or SiteStyles in Style view.



Last. Lets you toggle between the current    view and the last one that was displayed.



Recent. Opens a scrollable selection list of views and pages that have been displayed during the current 
NetObjects Fusion session.



Help Topics. Opens the NetObjects Fusion Help Contents dialog. Launches your browser to view the table of 
contents for the online Getting Started Manual.    This document is in HTML format.



About NetObjects Fusion. Opens the NetObjects Fusion version information box.



Getting Started. Introduces you to the NetObjects Fusion Help system.    Links to the online Getting Started 
Manual and NetObjects web site by launching your browser.



Preview. Creates HTML files and auto-generated images for every page in your site and places them in a Preview
folder on your hard disk. Also opens your default browser to let you view either the entire site or the current page.



Files. Shows you a list of files (such as pictures, audio, video, external HTML documents, Java applets, etc.) that 
are associated with your site. You can use the list to manage these files and their associations.



Data Objects. Shows you a list of data objects that are associated with your site. Data objects define data-based 
information from either internal or external sources You can use the list to remove the data object from your site or 
edit the data object definition.



Text properties. 



Layout properties. 



Picture properties. 



Links. Shows you a list of page, smart, and external links that are associated with your site, as well as the page or
pages on which each link appears.



Page. Takes you to the Page view where you lay out your pages and add content. Content includes: text, pictures, 
drawn shapes, tables, sound, video, Java applets, Active X controls, Shockwave files, data-based information and 
form elements.



Style. Takes you to the Style view where you create, manage and browse the SiteStyles available for use within 
your site.



Site Structure View. Switches you to a graphical view of your site. You can use this view to rename pages, add 
new pages and delete pages from your site. You can also expand and collapse the structure and color code 
individual pages.
Style Gallery.    Lists all the SiteStyles™ that can be applied to your site, along with a preview pane that lets you 
examine the various components that make up the style. To edit any style or component, click Components.



Site Outline View. Switches you to a tree view of your site in which you can expand and collapse the structure at 
any level. You can also review site management information about each page, such as the names of child pages, 
page type, status, and comments.
Style Components. Opens a list of elements that make up the current style. You can select and Edit any of these 
components and immediately see the results in the preview pane. To switch back to the site selection list, click 
Style Gallery. 



To view help on individual buttons, controls or elements, right-click on the item and choose "What's This" or "Help" 
from the pop-up menu.



To view help on individual buttons, controls or elements, right-click on the item and choose "What's This" or "Help" 
from the pop-up menu.



HID_NEWPUBLISHINGSET. 



HID_POPUP_MENU. 



HID_VIEW_AUTOSIZE. 



HID_INDICATOR_DATE. 



HID_INDICATOR_TIME. 



Choose this option if you want a solid color background on this page.



Click this button to go to the next page within this stacked page.



Click this button to add a current page within this stacked page.



Click this button to delete the current page within this stacked page.



HID_SECTION. 



HID_NEW2. 



Settings... Opens a dialog that allows for configuring your settings for local or remote staging or publishing. Also 
allows for choosing modifiers: text only, greyscale, and low-bandwidth versions.



Stage. Stages your site by writing HTML, assets and other files to your hard disk or a server that has restricted 
access.



Publish. Publishes your final site by writing HTML, assets and other files to your hard disk or a web server.



When checked, borders are displayed around objects such as text blocks, draw objects, data fields, and so on, in 
Page view.    This option is also found on the View menu.



HID_DRAW_SELECTION. 



HID_DRAW_RECT. 



HID_DRAW_ROUNDRECT. 



HID_DRAW_LINE. 



HID_DRAW_ELLIPSE. 



HID_DRAW_TEXT. 



HID_DRAW_PICTURE. 



HID_DRAW_POLYGON. 



HID_DRAW_OLE. 



HID_DRAW_JAVA. 



HID_DRAW_DBLIST. 



HID_DRAW_DBFIELD. 



HID_DRAW_FORMBUTTON. 



HID_DRAW_FORMRADIO. 



HID_DRAW_FORMCHECKBOX. 



HID_DRAW_FORMEDIT. 



HID_DRAW_FORMPSW. 



HID_DRAW_FORMCOMBO. 



HID_DRAW_FORMCLEAR. 



HID_DRAW_ZOOMIN. 



HID_DRAW_ZOOMOUT. 



HID_DRAW_TABLE. 



HID_DRAW_GRAPHIC. 



HID_DRAW_HOTSPOTRECT. 



HID_DRAW_HOTSPOTROUNDRECT. 



HID_DRAW_BACKGROUNDPICKER. 



HID_DRAW_SHOCKWAVE. 



HID_DRAW_SOUND. 



HID_DRAW_VIDEO. 



HID_DRAW_ACTIVEX. 



HID_DRAW_FORMMULTIEDIT. 



HID_CANCEL_EDIT_CNTR. 



HID_VIEW_GRID. 



HID_VIEW_ZOOM_IN. 



HID_VIEW_ZOOM_OUT. 



HID_PAGE_NEWPAGE. 



HID_PAGE_DELETEPAGE. 



HID_OBJECT_LINECOLOR. 



HID_VIEW_DIAGONAL. 



HID_OBJECT_FILLCOLOR. 



HID_VIEW_VERTICAL. 



HID_OBJECT_MOVETOFRONT. 



HID_OBJECT_MOVEFORWARD. 



HID_INDEX. 



HID_VIEW_PAPERCOLOR. 



Click this button to go to the previous page within this stacked page.



HID_NEW_CHILD. 



HID_NEW_SIBLING. 



HID_PREVIEW. 



HID_OPEN_NODE. 



HID_OBJECT_FONT. 



HID_OBJECT_FILLCOLOR2. 



HID_OBJECT_LINECOLOR2. 



HID_OBJECT_FONT2. 



HID_FONT_BOLD. 



HID_FONT_ITALICS. 



HID_FILE_SUMMARYINFO. 



HID_FONT_UNDERLINE. 



HID_FONT_TEXTCOLOR. 



HID_STYLE_LEFT. 



HID_STYLE_CENTER. 



HID_STYLE_RIGHT. 



HID_TEXT_BULLET. 



HID_LAYOUT_FONT. 



HID_LAYOUT_TITLE. 



HID_LAYOUT_PICTURE. 



HID_LAYOUT_COLOR. 



HID_LAYOUT_FIXEDFONT. 



HID_OBJECTDEFINITION. 



HID_NEWPUBLISHSET. 



HID_SETPUBLISHSET. 



HID_PUBLISH_NEWPUBLISHSET. 



HID_AlLIGNOBJECTS. 



HID_ASSIGNLAYOUTS. 



HID_ALIGN_HORIZONTAL. 



HID_INSERTSECTION. 



HIDM_BROWSER_OPTIONS. 



Indents text within a text box.



Unindents text within a text box.



Counts words, lines, paragraphs and characters within a single text box or on the whole page.



Provides a dialog box for you to select ASCII characters (such as © or ™) from a list and insert them into the 
selected text block.



HID_FILE_DUMPHTML. 



HID_DRAW_SELECT. 



HID_DRAW_POLY. 



HID_LAYOUT. 



HID_OUTLINE. 



HID_DELETE. 



HID_TOP_LEVEL_MENUS. 



HID_OBJECT_COMMENTS2. 



This option allows you to set the start value of a numbered list when the selected text block uses the numbered list
(also called ordered list) paragraph style. 



HID_ADDSTYLETOLIST. 



Help Overview. Explains how to get help with NetObjects Fusion by launching your browser and opening a locally
installed HTML file.



HID_INDICATOR_ZOOM. 



HID_INDICATOR_POSITION. 



HID_INDICATOR_CUROBJ. 



HID_ERR_LAYOUTTOOSMALL. 



Select object. Use this tool to select any page element in Page view or page symbol in Site view.



Rectangle. Clicking on this object reveals the Rectangle tab of the Properties palette. Use the settings on this tab 
to modify the Rectangle’s attributes.



Round Rectangle. Clicking on this object reveals the Round Rectangle tab of the Properties palette. Use the 
settings on this tab to modify the Round Rectangle’s attributes.



Rule. Clicking on this object reveals the Rule tab of the Properties palette. Use the settings on this tab to modify 
the Rule’s attributes.



Ellipse. Clicking on this object reveals the Ellipse tab of the Properties palette. Use the settings on this tab to 
modify the Ellipse’s attributes.



Text. Clicking on this object reveals the Text tab of the Properties palette. You can format selected text using the 
Text Properties palette. To type in new text or change existing text, just click in the text box using the selection tool.
To move or change the shape of the text box, make sure that you first click on the edge of the box using the 
selection tool.



Picture. Clicking on this object reveals the Picture tab of the Properties palette. Use the settings on this tab to 
modify the Picture’s attributes 



Polygon. Clicking on this object reveals the Polygon tab of the Properties palette. Use the settings on this tab to 
modify the Polygon’s attributes.



Ole Object. Use the Ole Object Properties palette to modify attributes of this element.



Java Applet or NetObjects Component. Clicking on this object reveals the Java Applet tab of the Properties 
palette (if a Java Applet) or the Component tab of the Properties palette (if a NetObjects Component). Use the 
settings on this tab to modify the Java Applet’s or Component's parameters.



Data List. Clicking on this object reveals the Data List tab of the Properties palette. Use the settings on this tab to 
modify the Data List’s attributes.



Data Field. Clicking on the edge of the red data field box reveals the Data Field tab of the Properties palette. Use 
the pull-down menu on this tab to select another data field.



Forms Button. Clicking on this object reveals the Button tab of the Properties palette. Use the settings on this tab 
to modify the Button’s attributes.



Forms Radio Button. Clicking on this object reveals the Radio Button tab of the Properties palette. Use the 
settings on this tab to modify the Radio Button’s attributes.



Forms Checkbox. Clicking on this object reveals the Checkbox tab of the Properties palette. Use the settings on 
this tab to modify the Checkbox’s attributes.



Forms Edit Field. Clicking on this object reveals the Single Line tab of the Properties palette. Use the settings on 
this tab to modify the Edit Field’s attributes.



HID_PALETTE_FormPsw



Forms Combo Box. Clicking on this object reveals the Combo Box tab of the Properties palette. Use the settings 
on this tab to modify the Combo Box’s attributes.



Forms Button. Clicking on this object reveals the Button tab of the Properties palette. Use the settings on this tab 
to modify the Button’s attributes.



Zoom in. .



Zoom out.



Table. Clicking on this object reveals the Table tab of the Properties palette. Use the settings on this tab to modify 
the table’s attributes. When you right-click on the table’s cells you can choose items that let you add or delete 
columns and rows or change the type of information in the current cell.



Picture. Clicking on this object reveals the Picture tab of the Properties palette. Use the settings on this tab to 
modify the Picture’s attributes (Note: Banners are also considered Pictures). 



Hot Spot (Rectangle). Use the Hot Spot properties palette to view or change the link attached to this hot spot.



Hot Spot (Polygon). Use the Hot Spot properties palette to view or change the link attached to this hot spot.



Hot Spot (Ellipse). Use the Hot Spot properties palette to view or change the link attached to this hot spot.



Background Color Selector. Use the Background Properties palette to modify attributes of this element.



Shockwave. Clicking on this object reveals the Shockwave tab of the Properties palette. Use the settings on this 
tab to modify the attributes of the Shockwave file.



Sound. Clicking on this object reveals the Sound tab of the Properties palette. Use the settings on this tab to 
modify the Sound file’s attributes.



Video. Clicking on this object reveals the Video tab of the Properties palette. Use the settings on this tab to modify
the Video file’s attributes.



ActiveX. Clicking on this object reveals the ActiveX tab of the Properties palette. Use the settings on this tab to 
modify the ActiveX control’s parameters.



Forms Multi-Line. Clicking on this object reveals the Multi-Line tab of the Properties palette. Use the settings on 
this tab to modify the Multi-Line form attributes.



Line. Clicking on this object reveals the Line tab of the Properties palette. Use the settings on this tab to modify 
the Line’s attributes.



Settings… Opens a dialog that allows for configuring your settings for local or remote staging or publishing. Also 
allows for choosing modifiers: text only, greyscale, and low-bandwidth versions.



HID_DELETE_ELEMENT .



HID_DELETE_FILE_ASSET .



HID_DELETE_LINK .



HID_DELETE_PAGE .



HID_EDIT_CLEAR_ITEMNAME .



HID_EDIT_CLEAR_STYLE .



HID_GOTO_PAGE .



HID_IMPORT_ITEMNAME .



HID_IMPORT_PAGE .



HID_IMPORT_STYLE .



HID_NEW_DATA_OBJECT .



HID_NEW_FILE_ASSET .



HID_NEW_ITEMNAME .



HID_NEW_LINK .



HID_NEW_PAGE .



HID_NEW_STYLE .



HID_NEXT_TAB .



HID_PREVIOUS_TAB .



Removes link previously associated with the selected text.



Delete All Unused File Assets.    Scans and deletes all unused file assets found in the File Assets view.



Vertical Navigation Bar.    Clicking on this object reveals the Nav Bar Properties palette. Use the settings on the 
property sheet to modify the vertical navigation bar’s attributes.    Click on individual buttons within the navigation 
bar to reveal the Button Properties palette.



Follow Link.    Goes to the destination of the selected element's internal or structural link.



HID_NEW_ASSET



HID_DRAW_POPMENU



HID_DEBUG_LINKASSETS



HID_DRAW_VERTBANNER



Insert HTML.  Opens the Insert HTML Tag dialog box where you may specify HTML tags or scripts to be inserted 
into the raw HTML source for the active text block, at the insertion point.    A small T icon will appear in the text 
block where the HTML was inserted if the Show links and anchors option is checked in the View properties palette.



HID_VERIFY_ASSET



Insert Variable.    Opens the Insert Variable dialog box where you may specify a Variable (either Date and Time, 
Site and General, or User defined) to be inserted into the active text block at the insertion point.    The variable will 
appear grey within your text block. 



HID_DRAW_COMPONENT



HID_LAYOUT_EXTERNAL



HID_PRINT_TO_FIT



HID_DRAW_NAVBAR



HID_DRAW_FORMTOOL



HID_DRAW_ODBC



HID_DRAW_ISAM



Size Layout to Elements.    Choose this option to resize the current Layout to fit the elements within it.    Extra 
space to the right or bottom of layout elements will be removed.    If elements within the MasterBorder extend 
beyond elements in the Layout, only the extra space beyond the MasterBorder elements will be subtracted from 
the current Layout size.    



HID_DRAW_BBS



HID_DELETE_ASSET



Verify All File Assets.    Scans the File Assets view to verify which files are used in the current site, and whether 
any files in use have incorrect path information.    The Verifying Files (or Folders) Used by File Assets dialog box 
opens if NetObjects Fusion finds any missing files.    See further help within that dialog box.
Verify All Links.    Verifies that all external links in Link Assets view are up to date and working properly (internally 
links are dynamically updated).    This action may take some time, depending on the number of external links and 
the speed of your internet connection.    The status of the URL is displayed in the Verify Status column.



Layout Only.    Choose this option to display the current Layout without displaying the MasterBorder. 



HID_EDIT_HTML



Click here to close the Spelling dialog box and cancel your spell check session.



HID_DRAW_VERTBAR



Spell Check.    Choose this option to check the spelling of text within text objects on the current page. 



HID_DRAW_ARROWLINE



HID_FILE_INSTALLCOMPONENT



HID_TEXT_UPDATEFIELD



HID_FLUSH_REDO



Save Site As.    Opens a standard Windows Save As dialog box.    Allows you to save a copy of the current site (a 
NetObjects Fusion .nod file) with a different name.



HID_DRAW_BANNER



When checked, small icons representing links, anchors, scripts or HTML tags (within text blocks) are displayed on 
elements in Page view.    This option is also found on the View menu.



Click this button to delete the currently selected tag from the text.



Variables. Shows you a list of User defined text variables that are used within your site, as well as the page or 
pages on which each variable appears.



Banner. Clicking on a banner reveals the Banner Properties palette.    Use the settings on the property sheet to 
modify this Banner’s attributes.    



Navigation Bar. Clicking on a banner reveals the Nav Bar Properties palette.    Use the settings on the property 
sheet to modify this Navigation Bar’s attributes.



Vertical Banner. Clicking on a banner reveals the Banner Properties palette.    Use the settings on the property 
sheet to modify this vertical Banner’s attributes.



HID_PALETTE_BBC



HID_PALETTE_ImageText



HID_PALETTE_BBSComp



HID_PALETTE_SiteMapperComp



HID_PALETTE_PopMenuComp



HID_PALETTE_FormToolComp



HID_PALETTE_BillBoardComp



HID_PALETTE_ODBC_DBList



HID_PALETTE_ISAM_DBList



HID_PALETTE_TickerTape



HID_PALETTE_MAXSHAPE



HID_INDICATOR_EXT



HID_INDICATOR_CAPS



HID_INDICATOR_NUM



HID_INDICATOR_SCRL



HID_INDICATOR_OVR



HID_INDICATOR_REC



HID_INDICATOR_KANA



HID_SEPARATOR



HID_FILE_NEW



HID_FILE_OPEN



HID_FILE_CLOSE



HID_FILE_SAVE



HID_FILE_SAVE_AS



HID_FILE_PAGE_SETUP



Print Setup.        Open the standard Windows Print Setup dialog box, with the addition of a Print to fit checkbox 
option.



Print.     Open the standard Windows Print dialog box, with the addition of a Print to file checkbox option.



HID_FILE_PRINT_DIRECT



Print Preview.    Displays a preview of the printed Site Structure.    The Site view will be replaced with the standard
Print Preview controls, which include Zoom In and Out, Print and other buttons.



HID_FILE_UPDATE



HID_FILE_SAVE_COPY_AS



HID_FILE_SEND_MAIL



Most Recently Used (MRU) Sites. Ordered list of the last several sites that you opened. To reopen a saved site, 
click its name on the MRU list.



Most Recently Used (MRU) Sites. Ordered list of the last several sites that you opened. To reopen a saved site, 
click its name on the MRU list.



Most Recently Used (MRU) Sites. Ordered list of the last several sites that you opened. To reopen a saved site, 
click its name on the MRU list.



Most Recently Used (MRU) Sites. Ordered list of the last several sites that you opened. To reopen a saved site, 
click its name on the MRU list.



Most Recently Used (MRU) Sites. Ordered list of the last several sites that you opened. To reopen a saved site, 
click its name on the MRU list.



Most Recently Used (MRU) Sites. Ordered list of the last several sites that you opened. To reopen a saved site, 
click its name on the MRU list.



Most Recently Used (MRU) Sites. Ordered list of the last several sites that you opened. To reopen a saved site, 
click its name on the MRU list.



Most Recently Used (MRU) Sites. Ordered list of the last several sites that you opened. To reopen a saved site, 
click its name on the MRU list.



Most Recently Used (MRU) Sites. Ordered list of the last several sites that you opened. To reopen a saved site, 
click its name on the MRU list.



Most Recently Used (MRU) Sites. Ordered list of the last several sites that you opened. To reopen a saved site, 
click its name on the MRU list.



Most Recently Used (MRU) Sites. Ordered list of the last several sites that you opened. To reopen a saved site, 
click its name on the MRU list.



Most Recently Used (MRU) Sites. Ordered list of the last several sites that you opened. To reopen a saved site, 
click its name on the MRU list.



Most Recently Used (MRU) Sites. Ordered list of the last several sites that you opened. To reopen a saved site, 
click its name on the MRU list.



Most Recently Used (MRU) Sites. Ordered list of the last several sites that you opened. To reopen a saved site, 
click its name on the MRU list.



Most Recently Used (MRU) Sites. Ordered list of the last several sites that you opened. To reopen a saved site, 
click its name on the MRU list.



Most Recently Used (MRU) Sites. Ordered list of the last several sites that you opened. To reopen a saved site, 
click its name on the MRU list.



Most Recently Used (MRU) Sites. Ordered list of the last several sites that you opened. To reopen a saved site, 
click its name on the MRU list.



Most Recently Used (MRU) Sites. Ordered list of the last several sites that you opened. To reopen a saved site, 
click its name on the MRU list.



HID_EDIT_CLEAR



HID_EDIT_CLEAR_ALL



HID_EDIT_COPY



HID_EDIT_CUT



HID_EDIT_FIND



HID_EDIT_PASTE



HID_EDIT_PASTE_LINK



HID_EDIT_PASTE_SPECIAL



HID_EDIT_REPEAT



HID_EDIT_REPLACE



HID_EDIT_SELECT_ALL



HID_EDIT_UNDO



Redo.    Redoes the previously undone action or command, which is displayed with the menu item. 



HID_WINDOW_NEW



HID_WINDOW_ARRANGE



HID_WINDOW_CASCADE



HID_WINDOW_TILE_HORZ



HID_WINDOW_TILE_VERT



HID_WINDOW_SPLIT



HID_APP_ABOUT



HID_APP_EXIT



HID_HELP_INDEX



HID_HELP_FINDER



HID_HELP_USING



HID_CONTEXT_HELP



HID_HELP



HID_DEFAULT_HELP



HID_NEXT_PANE



HID_PREV_PANE



HID_FORMAT_FONT



HID_OLE_INSERT_NEW



HID_OLE_EDIT_LINKS



HID_OLE_EDIT_CONVERT



HID_OLE_EDIT_CHANGE_ICON



HID_OLE_EDIT_PROPERTIES



HID_OLE_VERB_FIRST



HID_OLE_VERB_LAST



HID_VIEW_TOOLBAR



HID_VIEW_STATUS_BAR



HID_RECORD_FIRST



HID_RECORD_LAST



HID_RECORD_NEXT



HID_RECORD_PREV



HID_APPLY_NOW



HID_WIZBACK



HID_WIZNEXT



HID_WIZFINISH



Size to Image.    Choose this option to resize the bounding box of the current image to fit the picture exactly.    
Regardless of the current size of the picture bounding box, it will reset to the picture's original dimensions.



Element Borders.    Toggles the display of borders around objects (such as text blocks, draw shapes, data fields, 
etc.) in Page view.    This option is also found on the View properties palette.



Page Labels.    Toggles the display of small text labels and dividing lines for page areas such as MasterBorder, 
Layout and Frames.



Element Icons. Toggles the display of small icons representing links, anchors, scripts or HTML tags (within text 
blocks) on elements in Page view.    This option is also found on the View properties palette.



Update Styles List.    Updates your SiteStyle list (Style Gallery in Style view) by importing all styles found in your 
NetObjects Fusion\Styles folder and removing all those not found.    Styles found in the Styles folder but not found 
on your Styles list are imported, and styles found on your Styles list but not found in your Styles folder are 
removed from the list.



HIDR_DRAWCLTYPE.
 This topic is under construction.



HIDR_T2TYPE_CNTR_IP.
 This topic is under construction.



HIDR_MAINFRAME.
 This topic is under construction.



HIDR_TEXTMENU.
 This topic is under construction.



HIDR_STYLES_MENU.
 This topic is under construction.



HIDR_ASSETS_MENU.
 This topic is under construction.



HIDR_PUBLISH_MENU.
 This topic is under construction.



HIDR_DELETE_PAGE_MENU.
 This topic is under construction.



HIDR_PAGE_MENU.
 This topic is under construction.



Please select an individual button, option or control and right-click “What’s This” to view context-sensitive help for 
that control.



HIDP_BUSY.
 This topic is under construction.



HIDP_FAILED_TO_CREATE.
 This topic is under construction.



HIDP_SOCKETS_INIT_FAILED.
 This topic is under construction.



HIDP_OLE_INIT_FAILED2.
 This topic is under construction.











Enter the point size for the line width or graphic element border. Each click on a spin button changes the current 
size by one point.



Reveals (if checked) or hides (if cleared) any hotspots that have been applied to the selected picture. Since 
hotspots normally aren't visible on a picture when viewed in a web browser, this feature is used for design 
purposes only.





Sets the page background color or design to match the current site style as shown in the Style view.



Choose this option if you want a solid color background on this page.



Choose this option if you want a graphic background on this page.



Opens a color dialog to let you choose a solid color background for this page.



Opens a standard Windows search dialog to let you locate a picture to use for the background on this page.







Check or uncheck this box to switch the page design grid on or off.







Displays the path and file name for the current picture. You can change the picture by typing in a new path and file 
name or by clicking the Browse button to locate a file on disk.



 Displays the link assigned to the selected hotspot. You can edit this text directly to change the link, or press the 
Link button to help you specify a new link.



Lets you choose the type of template you wish to apply to the site.



Select the next data field to query on.    



Select the next data field to query on.    







Lists all available web browsers. Select the browser from this list that NetObjects Fusion will launch when you click
the Preview button in the control bar. 





Opens the Add Browser dialog, which lets you specify a browser to add to the list.



Lets you remove the selected browser from the list.



Sets the web browser that NetObjects Fusion will launch when you click the Preview button in the control bar. The 
web browser documents are indicated in the browser selection list.



















Shows the current fill color for the selected graphic element. To change the color, click the Color button.



Opens a color selection dialog to let you change the fill color for the selected graphic element.



Opens a standard file Open dialog box to let you locate a file.



Displays the name of the currently selected proportional font used throughout your site.



Applies underline formatting to the selected text.



Applies strikeout formatting to the selected text.





Lists available point sizes for the selected text. The list also shows the corresponding HTML standard sizes. 





Opens the Link dialog to let you link to another page within your site or to another page or site on the Internet. The 
link is applied only to the selected text. If no text is selected, the button is disabled.



Enter the name of your new paragraph style here.







Opens a color selection dialog to let you change the background color in the selected text.















Displays the file name represented by the selected element. 



Click this button to open a file search dialog and locate a sound or video file to place on the page.



Click one of these buttons to place a supplied icon to represent your page.



Click this option to select from one of the supplied sound or video images. To choose an image, click its button.



Click this option to select a custom image or icon to represent the sound or video. To locate an image on your disk,
click the File button.



Opens a file search dialog to let you locate an image or icon to represent the sound or video.



Displays the file name of a selected image or icon that represents the sound or video.







Choose a Layout for the current page from this dropdown list.    Choose Add… from the dropdown list to create a 
new page layout based on the current page.









Check this option if this name-value pair is to be selected by default.



Makes the edit box a password control. Any text entry is displayed as asterisks. 





Choose this option if you want to allow the user of the form to make multiple selections from the items in your list 
box.



Check this option to additionally publish or stage your site as a greyscale site.    All images (GIFs and JPEGs) are 
published or staged as two-color monochrome.



Check this option to additionally publish or stage your site as a low bandwidth site.    All GIFs are reduced to 4-bit 
color (16 color) and all JPEGs are reduced in file size by half (they are resized in your browser to their original 
dimensions).







Displays the name of the selected data list. If you are creating a new data list, enter a name here (the default is 
“Untitled”). This data list name is for internal reference only. Open the Data Publishing dialog box by either double-
clicking on the Data List itself or by clicking the Define button in the Data List properties palette.





Enter the name for this new data object sourced with internal data.    This edit box is unused by data objects 
sourced with external data.



Displays the name and type of each data field within this data object. Double-click on a field to edit its name. Click 
on the add button (+) below to add data fields to this data object.    



Enter any comments for this object here (for internal purposes only).







Lets you change the name of the currently selected page.





Enter or select a column number to change its settings.    Use the dropdown list below to change the type of object 
contained within the specified column. Change settings for multiple columns by selecting columns here and 
changing their object types below 



Point size for the external border on the selected data list.



Select a method of comparison from this dropdown list for this relational query



Enter the value to be compared (according to the comparison method) in the specified data field.



Select a logical conjunction (“and” or “or”) to define the relational query.    Select “end” to end your query without 
specifying further conditions.





Enter the value to be compared (according to the comparison method) in the specified data field.





Enter the password for the username indicated above.



Enter your username for the web server you wish to publish or stage to in this edit box.



The location of the selected file is displayed here.























Identifier for the control.





Makes the default state of the control "not selected" or "unchecked."



Choose this option to have the selected radio button be selected by default when the form element is viewed 
within a browser.



Choose this option to have the selected radio button be unselected by default when the form element is viewed 
within a browser.



Click the up or down arrows to change the grid block width in increments of one unit.



Click the up or down arrows to change the layout height in increments of one unit.



Enter or select a column number to change its settings. Use the dropdown list below to change the type of object 
contained within the specified column. Change settings for multiple columns by selecting columns here and 
changing their object types below 



Lets you increase or decrease the point size for the outside border on the selected table or data list. Each click on 
a spin button changes the size by one point. For larger changes, type a new number into the field.



Lets you increase or decrease the margin, in points, between the cell contents and container edges. Each click on 
a spin button changes the size by one point. For larger changes, type a new number into the field



Lets you increase or decrease the amount of space (in points) between each column and between the outside 
border and the column containers. Each click on a spin button changes the size by one point. For larger changes, 
type a new number into the field.



Choose this option to select a image file to use as a bullet in the selected data list.    Click on the browse button to 
open a standard Image File Open dialog box.



Check this option to if you do not want to use bullets within the selected data list.



Indicates that the current page is not yet completed.



Choose this option to set the navigation button level to documents on the same level of the site hierarchy as the 
current page.







Moves the selected parameter or item up one position on the list.









Displays the graphic in its original size and shape within the picture container. The picture maintains its "natural" 
state even if you change the size or shape of the container using the sizing handles.





If the selected picture container is enlarged beyond the size of the graphic it contains, this option creates multiple 
images of the graphic and tiles the images to fill the container.



Click the up or down arrows to change the layout width in increments of one unit.



Shows the color that will be applied to the selected text container background if you choose the background color 
option. To change the color, click the Color button. 











Enables or disables the snap to grid feature when checked or unchecked.    Grid height and width settings may be 
modified above.



Lets you change the measurement units used in determining the height and depth of the page as well as the grid 
size used to position objects on the page. Choose from centimeters, inches, points or pixels. Your choice is used in
the Grid Size controls below as well as in the Layout and MasterBorder properties palettes.



Choose this option to use the primary button style as shown in the current style (Style view) for the selected 
navigation button.



Choose this option to use only text for the selected navigation button.



Choose this option to use the secondary button style as shown in the current style (Style view) for the selected 
navigation button.











Check this option to additionally publish or stage your site as a text only site. Non-text assets such as images or 
sound files will not be included in the published or staged site.





Displays the current page type (Normal or Stacked).







Shows the color of the background that is applied to the picture container if you select the Use Current Color 
option.



Area in which you can enter additional comments about the currently selected page.



Opens a color dialog to let you set the color of individual page icons in Site view for various purposes, such as 
indicating which pages have been assigned to a particular author.



Shows the color of the currently selected page icon. To change the color, click the Color button.



Opens a color dialog to let you set the color of the Site view background.



Opens a color dialog to let you set the color of the Site view background.





Outline View. Provides a drag and drop file tree view of your site in which you can expand and collapse the 
structure at any level. You can review site management information about each page, such as the names of child 
pages, page type, status, and comments.





These options let you control how a graphic is displayed within the selected picture bounding box.



 These controls let you apply text to the selected picture or graphic container and choose the color, alignment and 
font for the applied text. 



Choose this option if you would prefer a solid color as a background for this style. Click on the Color button to 
select a new color.



Choose this option if you would prefer a picture as a background for this style. Click on the Browse button to 
browse for a picture. A sample of how the tiled picture will appear as a background style is displayed on the right.



Click this button to open the standard Color dialog box, where you can select a color for the background style. 



Adds the current footer to the Footer list, making it available to all other pages in your site.



Adds a new MasterBorder to the MasterBorders list based on the current page’s MasterBorder, making it available 
to all other pages in your site.    Name and format the new MasterBorder from the MasterBorder properties palette.





Closes the dialog and saves any changes you made.



Displays the URL (internet address) for this external link.





Enter, edit or view the value displayed in this edit box.



Choose this option to make the control a dropdown type list box, which takes up less space on the form. The user 
opens the list by clicking a button.



You've selected a text buttonface.    Enter the text you would displayed on the button, and specify whether it is a 
Submit or Reset button.



Displays the name of the style to be edited.



If checked, places the Banner button (as shown in the Styles view) in the page header.



Lets you choose a new footer for this page.





Lists the ActiveX controls available on your system. Select the ActiveX control to be inserted into the current 
selection.



Lists the properties available in the selected ActiveX control.







The left button aligns text flush left, the middle button aligns text to the center and the right button aligns text flush 
right.    When working in a text block, these buttons affect the current paragraph.    When working with Text in 
Element Settings (in Page view) or Text Settings (in Style view) these buttons affect the relative alignment of text 
only, not its relation to the element (use Horizontal and Vertical Position for this).





Displays the current background color of the selected data list or table. To change the color, click the Color button.



Enter the name of the remote host or server you wish to publish to.



Check here to have your password stored in memory.    If checked, you will not need to enter your password each 
time you publish.





Check this option to use the current default bullet style (as shown in Style view) in the selected data list.



Lets you switch between vertical and horizontal orientation.



Check or clear this box to show or hide column headers in the selected data list.



Chooses the file extension for the HTML file generated for the home page of your site.    The default choice, html, 
used by UNIX and Macintosh computers, is more commonly found on the World Wide Web; htm is used by IBM-
PC compatibles with its three-character extension limit.



Shows the date and time the current site was created.



Shows the date and time the current site was last changed.



Shows the color of the Site view background. To change the color, click the Color button. 











Enter the directory on the remote host you wish to start in.







Displays a list of symbol characters, with descriptions and Shortcut keys (if applicable) which can be inserted into 
a text block. Use Shortcut key combinations outside this dialog box, when entering text into a text block.    Insert 
the selected symbol into the text block at the insertion point by pressing the Insert button below.



Check this box to use a highlighted button (as shown in the current style) in the navigation bar.    Note: this option 
has no effect on nav bars with text buttons.



Check this box to include this site's home page in the navigation bar.



Displays the number of words in the current page.





Displays the number of characters in the current page.



Displays the number of lines in the current page.



Displays the number of words in the current text selection.



Displays the number of lines in the current text selection.



Displays the number of paragraphs in the current text selection.



Displays the number of characters in the current text selection.



Structure View. Provides a drag and drop graphical view of your site. You can use this view to visualize your site’s
structure. You can also expand and collapse the structure and color code individual pages.





Finds the selected page and opens it in Page view.



Opens a pre-built ActiveX control Properties dialog box (if available), where you may edit the ActiveX control's 
properties.    Also use this property palette to modify ActiveX properties within NetObjects Fusion (for further 
information, see help on other controls within this palette).



Displays the color that will be applied to the selected line or element border. To change the color, click the Color 
button.



Select a method of comparison from this dropdown list for this relational query



Displays the color that will be applied to the selected text if you choose the color option next to the swatch. To 
change the color, click the Color button.







Name assigned to the current page. You can change this name at any time.



Enter or select the number of rows for your table here.



Applies italic formatting to the selected text.



Name assigned to the current page layout. You can change this name at any time.



Opens a standard Windows file Open dialog box to let you locate a file.





 Opens an alignment dialog to let you position text within the selected picture or graphic element. Applies only if 
the Text in Element checkbox is checked and text appears in the field above the Align button.



Displays the current picture used for the banner in this style.    Click on the Browse button to select a new picture.



Displays the Font currently selected for this style element.



Click here to open the standard Font dialog box, where you may select fonts and font styles to be applied to the 
text used in this style element.





This displays the current background style color.    Click on the Color button to change this color.



Displays the current picture used for the background in this style. Click on the Browse button to modify this 
selection.



Displays the current picture used for regular or non-highlighted buttons in this style. Click on the Browse button to 
modify this selection.



Displays the current picture used for highlighted buttons in this style. Click on the Browse button to modify this 
selection.



Click here to open the Image File Open dialog box, where you can select a picture for this style element.







Enter a full or partial name of the page within your site you wish to link the selected element to.    



Searches for pages beginning with the character(s) you’ve entered above.    Click on the Find button below to 
locate all matches.



Searches for pages which contain the character(s) you’ve entered above.    Click on the Find button below to 
locate all matches.



Searches for pages which end with the character(s) you’ve entered above.    Click on the Find button below to 
locate all matches.



Graphical display of the selected level.



Graphical display of the selected level.



Graphical display of the selected level.



Graphical display of the selected level.



Graphical display of the selected level.



Use these controls to apply the default color or choose a new color for the selected text.



Use these controls to add or remove background color in the selected text container.







Icon representing the audio controls element that is placed on the page when you choose the Inline option.





Opens a standard Windows search dialog to let you locate a picture to place on the selected button.



Displays the file name of the picture that appears on the selected button. If no picture is assigned to the button, 
this label is blank.    Click on the Browse button to select a picture file.



Set Style. Applies the selected style to the current site.



Page icon.    This icon is a representation of the actual page. Clicking on this icon reveals the Page tab of the 
Properties palette, where you may change the selected page's properties (also see help within the Page 
Properties palette).    Double-click on this page icon to edit the page in Page view, or click the right mouse button to
view a pop-up menu with applicable commands.
Stacked page icon.    Page icons with a layered lower edge are representations of stacked pages. Double-click on
a stacked page icon to edit the stacked page in Page view. 
External HTML file icon.  Page icons with diagonal hatching represent external HTML files used within your site. 
Double-click on this icon to go to the corresponding page in Page view.    To edit the external HTML file (with the 
editor specified in Edit | General Preferences),    double-click on the grayed-out layout in Page view.



Choose this option if the intended data object uses one of the pre-built database drivers listed in the dropdown list 
to the right.    Click on the Browse button to choose a file that matches the driver type specified in the dropdown 
list.



Click on this button to add a new field to your data object.



Opens a standard Windows search dialog to let you locate a file.



Type the text that will appear in place of the sound graphic in client browsers that either can't display images or 
have image display turned off.



Click to apply the selected action.



Removes the currently assigned link.



Lets you turn on/off the autosave feature, which automatically saves your site every time you make a change. 
Turning off (unchecking) this feature can improve overall performance when working with large sites, but if you turn
it off you MUST select Save Site from the File menu to save your work.



Type the text that will appear in place of the image representing the ActiveX control in client browsers that either 
can't display images or have image display features turned off.



Specify the file needed to implement this ActiveX control on the client side, almost always an .OCX files (less 
commonly.CAB or .INF files). Note: if the Set Codebase option was checked in the Insert ActiveX dialog box the 
necessary module will be automatically added to this edit box.    Also, the module used by a particular ActiveX 
control is displayed in the Insert ActiveX dialog box. See help for the Insert ActiveX dialog box.



Type the name of a script to run with the ActiveX control. To open the full script editing window, click the Script 
button.



Text will be aligned to the bottom of the style element.



Opens a standard Windows file Open dialog box to let you browse for files.



Opens the Image File Open dialog box, where you can select a new image or picture to be used for highlighted 
buttons in this style.







Opens a search dialog to let you choose a new bullet graphic for the selected data list. 



Opens the Enter Value dialog to let you add a new parameter or item.



Moves the selected parameter or item down one position on the list.



Removes the selected parameter or item from the list.



Opens a standard Windows Font selection dialog to let you choose a new monospace font and font size. You must
match these settings to the monospace, fixed or teletype font settings in your browser's preferences.



Opens a standard Windows Font selection dialog to let you choose a new proportional font and font size. You must
match these settings to the proportional font settings in your browser's preferences.





Click this button to assign a picture to the selected cell. When you select this option, a standard Windows search 
dialog appears to let you locate a picture. Caution: If the cell already contains text and you choose a picture to 
replace it, the text cannot be retrieved.



Click this button to enable text entry in the selected cell. Caution: If the cell already contains text and you assign a 
picture to it through the Picture type option, the existing cell text cannot be retrieved.



Chooses what type of element, text or picture, will appear in the Column number chosen in the edit box above. 
The default type is text.



Text will be aligned to the horizontal center of the style element.



Text will be aligned to the vertical center of the style element.



Enter the folder on the remote host where CGI (Common Gateway Interface) programs are located.    



Edit. Lets you edit the selected style element. You can also edit elements by double-clicking list items. 



Check this box to enable uploading only those file assets which have changed since the last time you've published
or staged.    If you've deleted or changed files on your server, disable this option to re-publish or re-stage your 
entire site (NetObjects Fusion doesn't compare the server's files).    This option is enabled by default. 







Select this option if you want to use the current page background color as the background in the picture container.



Check this option to use a transparent GIF to maintain WYSIWYG layout in Netscape Navigator 3.0 (and older 
versions).    The file "dot_clear.gif" will be used to display your site in Netscape as it appears within NetObjects 
Fusion.



Check this box to have NetObjects Fusion automatically place all data fields on the stacked pages associated with 
this data object and list.    Go to the stacked pages in Page view to manually adjust the layout of the data fields and
stacked pages.



Check this box to automatically add navigation buttons to the stacked pages associated with this data object and 
list.    NetObjects Fusion will add Next, previous and up buttons to the set of stacked pages. Go to a stacked page 
in Page view to manually adjust the layout and properties of navigation buttons on the stacked pages.











Displays the currently selected solid background color for this page. Only applies if the Solid Color option is 
selected. To change the color, click the Color button.





Lists the pre-built database drivers available for the intended data object.    Click on the Browse button to choose a 
file that matches the driver type specified in this list.



Select a data field to be added to the current stacked page from the dropdown list.



Select a method of comparison from this dropdown list to use for this query.



Enter the value to be compared (according to the comparison method) in the specified data field.



Elements. Lists the editable elements that make up the selected style. You can double-click on any item in the 
element list to edit it.



Clicking this button opens the SQL Data Sources dialog box, where you may add and select from a list of external 
data sources.



Opens the Data Publishing dialog box, where you can change the name assigned to this list, show or hide fields 
assigned to the list, assign the Linked Field attribute to fields in the list, change the order in which fields appear, 
and other options.



Choose from the current set of Data Objects to be included in your data list.    Choose the New Button to create a 
new data object.









Enter the path for the local folder in which you would like to stage or publish your site.    Click the Browse button to 
locate the folder.



If you make the control a standard list box, this field lets you set the number of lines that are displayed in the box. 
If there are more items in the list than the number you set here, a scroll bar is added



If you make the control a standard list box, these buttons increase or decrease the number of lines displayed in the
box. If there are more items in the list than the number you set here, a scroll bar is added.



Lets you change the text displayed on the element.



Click the up or down arrows to increase or decrease, in increments of one,    the maximum number of characters 
allowed in the edit box. If the box contains more text than shown in the Max Visible setting, the user can view the 
additional text by using the arrow keys to scroll right or left.



Enter the point size for the line width or graphic object border. Each click on a spin button changes the current size
by one point. 



Contains the value that will be returned when the form is submitted and this checkbox or option is selected. All 
checkboxes and radio buttons should have a name and a value assigned to them (otherwise, if the option is 
selected, and the form is submitted, the default string “On” is returned when the form is submitted).



The number of lines that are visible in the edit box (which determines the onscreen height of the box). If the box 
contains more lines than the Visible Height setting, the user can view the additional text by scrolling up or down 
using the keyboard .



Click these buttons to increase or decrease the number of lines that are visible in the edit box (which determines 
the onscreen height of the box). If the box contains more lines than the Visible Height setting, the user can view 
the additional text by scrolling up or down using the keyboard arrow keys.



The number of characters that are visible in the edit box (which determines the onscreen width of the box). The 
maximum number of characters the box can contain is set in the Max Length control.    If the box contains more 
characters than the Visible Length setting, the user can view the additional text by scrolling right or left using the 
keyboard arrow keys.



Click these buttons to increase or decrease, in increments of one,    the number of characters that are visible in the
edit box (which determines the onscreen width of the box). The maximum number of characters the box can 
contain is set in the Max Length control.    If the box contains more than the Visible Length setting, the user can 
view the additional text by scrolling right or left using the keyboard arrow keys.





Enter the text you would like to be inserted into the published HTML page after the selected element. Click the 
Insert button to insert a text or HTML file in this edit box. Click OK to confirm the insertion, Cancel to exit this dialog
without inserting or changing the script.



Sets the maximum number of characters allowed in the edit box. If the box contains more text than shown in the 
Max Visible setting, the user can view the additional text by using the arrow keys to scroll right or left.





The number of characters that are visible in the edit box (which determines the onscreen width of the box). The 
maximum number of characters the box can contain is set in the Max Length control.    If the box contains more 
characters than the Visible Length setting, the user can view the additional text by scrolling right or left using the 
keyboard arrow keys.











Select an initial data field to perform a Boolean query on.    



The file name and path for the picture that is displayed in the selected navigation control. To change the picture, 
click the Browse button.



Enter the number of pixels to offset your background image from the left margin.



This buttons opens the Query dialog box, which allows you to set database queries or filters for the data fields 
listed below (further help is available within the Query dialog box).



Choose this option to set the navigation button level to pages on the first level of the site hierarchy.





With the Get method, the values of the form variables are sent as part of the URL. This corresponds to the 
“METHOD=GET” attribute of the Form tag in HTML. 



Post is the default method used by forms.    The values of the form variables are echoed as text, whereas in the 
Get method the values are sent as part of the URL. This corresponds to the “METHOD=POST” attribute of the 
Form tag in HTML. 



Specify In this edit box specify the URL of the CGI script to be used by your site when processing forms. This 
corresponds to the “Action” attribute of the Form tag in HTML.    This field is required.





Advanced users may specify a local copy of the CGI script used for processing forms. The Action field below 
should contain the full URL for the CGI script selected above. This file will be FTP’d to the CGI directory indicated 
in your Remote configuration (Publish or Stage Settings). Note: if your CGI script is already on your web server, 
you may leave this field blank.



This field is optional. Advanced users may need to specify a non-standard encoding type when configuring 
advanced forms. (MIME-type application/x-www-form-urlencoded is the default encoding type, which encodes the 
form’s name-value pairs as an URL is encoded).



Click this button to open a standard Open File dialog and select a local CGI script.



Opens the Forms Settings dialog, where you set the CGI-related functions for the form.









Lets you view or change the width of the grid blocks that are used to help you position items on the page. You can 
change the block width by typing a number directly into this field or clicking the spin buttons to change the value in 
increments of one unit.



Displays the currently selected unit of measurement used in determining the width of each grid block. You can 
change the unit used by choosing another Measurement Unit from the list above.



Click the up or down arrows to change the grid block height in increments of one unit.



Lets you view or change the height of the grid blocks that are used to help you position items on the page. You can
change the block height by typing a number directly into this field or clicking the spin buttons to change the value 
in increments of one unit.



Displays the currently selected unit of measurement used in determining the height of each grid block. You can 
change the unit used by choosing another Measurement Unit from the list above.





Horizontally aligns the selected picture to the center of its bounding box, when the bounding box is sized differently
from the picture.



Horizontally aligns the selected picture to the left of its bounding box, when the bounding box is sized differently 
from the picture.



Horizontally aligns the selected picture to the right of its bounding box, when the bounding box is sized differently 
from the picture.



Lets you select a MasterBorder for the current page.





Opens the Hidden Fields dialog, which lets you add or remove hidden fields (not visible in the browser) from your 
form.





Chooses the name of the HTML file generated for the home page of your site, which can be either the current 
name of the page, Index, Default or Home.    Current Page Name is the default choice.





If this option is checked, headers and footers within this site will be oriented horizontally, i.e. headers will be at the 
top, footers at the bottom of each page. The header/footer splitter bars will be horizontal, at the top and bottom of 
each page.    If this option is unchecked, headers and footers within this site will be oriented vertically, i.e. headers 
will be on the left, footers on the right of each page. The header/footer splitter bars will be vertical, on the left and 
right of each page.



Choose this option to display a set of graphical audio or video controls on the page. This interactive element can 
be used to control the sound or video element from the client browser.





Choose this option to set the navigation button level to documents on the parent level of the site hierarchy.



Choose this option to set the navigation button level to documents on the child level of the site hierarchy.







Opens a standard file Open dialog box where you may select HTML or other text files to insert into the selected 
edit box (where the cursor is currently located).



Lets you type in an HTML alternate tag for the selected element. This text—generally a short description of the 
element—appears in place of the graphic representing the element in text-only web browsers or browsers in which
graphics have been turned off.



Displays the file name of the selected Java applet or Shockwave file.



Text you want displayed in the control.





Lets you view or change the width or height of the current page layout in terms of the selected unit of 
measurement. You can change the layout width or height by typing a new number directly into this field or clicking 
the spin buttons to change the value in increments of one unit.



Displays the currently selected unit of measurement used in determining layout and page size. You can change 
the unit used by clicking the View tab and choosing another Measurement Unit from the list. 



Displays the Page Type for the selected page, either Normal or Stacked Page (data pages used by a data list).



Opens a color selection dialog to let you choose a color for the table or data list background.



Lets you view or change the height or width of the current page layout in terms of the selected unit of 
measurement. You can change the layout height or width by typing a new number directly into this field or clicking 
the spin buttons to change the value in increments of one unit.



Displays the currently selected unit of measurement used in determining layout and page size. You can change 
the unit used by clicking the View tab and choosing another Measurement Unit from the list.





Text will be aligned to the left margin of the style element.







When this option is checked, the selected data list field above will be considered a linked field, which means that 
the data within that field is linked to its corresponding page within the set of stacked pages used by the current 
data list. When the data list is viewed in a browser, data displayed in the column for a linked field will be seen as 
highlighted links to the corresponding data pages (within the set of stacked pages). To indicate that a data list field 
is linked, "(link)" is added to the end of the fieldname on the list above.





Displays the URL (internet address) for this external link.



Displays all pages which contain this asset.



Lists the parameters of the selected items that are to appear in the selected list box. To change the current value 
of any parameter or item, double-click its name on the list. To add or remove a parameter or item, click the + or - 
buttons below the list. To reposition an item on the list, select the item and click the up or down arrow buttons.



Choose this option to stage or publish your site locally.    Enter or browse for the folder in which to stage or publish 
the folders of HTML pages and assets.







Displays the name of the currently selected monospace font in use throughout your site.







Displays the name of the selected asset.





Click this button to create a new data object.    The Data Object dialog box will open (see help on individual options
within the Data Object dialog box).    





Adds a new button to the header or footer navigation bar. The button picture is set in the Nav. Button properties 
palette.



Select the logical conjunction (“and” or “or”) to compare data fields.    Select “end” to end your query without 
specifying further conditions.









Select this button if the currently selected page is to be included in the published site. Note: All pages are normally 
included in the published site. To exclude a page, select the page and click the Don't Publish option. To include a 
previously excluded page, click the Publish option back on.







Displays a list of objects to be selected from.



The name of the selected ActiveX control or NetObjects Component.



Choose this option if the data object will use the Open Database Connectivity (ODBC) standard.    Click on the 
Select button to open a dialog where Data Sources and ODBC drivers for this data object are chosen.



Click this button to open the Data Source Type dialog box, where you specify the location and type of a data object
sourced with external data.



Select this button if the currently selected page is to be excluded from the published site.



Lets you change the name of the currently selected page.



Select this button if the currently selected page is to be included in the published site. Note: All pages are normally 
included in the published site. To exclude a page, select the page and click the Don't Publish option. To include a 
previously excluded page, toggle the Publish option back on.









Displays the data type (string, integer) required by the selected parameter.



Describes the required contents of the selected parameter.



Opens a color selection dialog to let you choose a color for the selected line or border on the selected graphic 
element. In the Line properties palette, you can only set the color when the Draw option is selected.



Opens a font selection dialog box to let you choose a font for the text that appears in the selected picture or 
graphic element. 



Opens the Link dialog box to let you add or change a hypertext link on the selected picture or graphic element. 
The link can point to another page within your site or to another page or site on the Internet.



Opens the Alignment dialog box which lets you choose the position the image "snaps" to if you change the size or 
shape of the container. If, for example, you choose Left and Bottom alignment and then enlarge the picture 
container, the picture will maintain its original size, but snap to the bottom left corner of the enlarged container.



Lets you type in an HTML alternate attribute (ALT) for the selected picture or graphic object. This text, generally a 
short description of the picture or element, appears in place of the image in text-only web browsers or browsers 
with graphical display turned off.



If this page uses an image for the background, the image file name is displayed here.



Stretches the graphic to fill the selected picture container's size and shape.



To add text to the selected picture, check the Text in Element checkbox, then type the text into this field.



Opens a color selection dialog to let you choose a color for the text that appears in the selected picture or graphic 
element. 











You've selected an image form button. Click on the Browse button to select a picture file.    By default, a graphic 
form button acts as a Submit button. 



Makes the button a "reset" control. When the user clicks the button in a client web browser, form contents on the 
page are cleared.



Makes the button a "submit" control. When the user clicks the button in a client web browser, form contents on the 
page are sent to the site.



Makes the default state of the control "selected" or "checked."





The image file will be converted from its currently file format to a .GIF file, one of the two image file types 
supported by most browsers. Choose JPEG below to convert the image to a .JPG file (called .JPEG on UNIX and 
Mac), the other image file type supported by most browsers.



Choose this option if you want to control the length, width, angle and color of the selected line.



Choose this option to make the selected line a horizontal rule.    An <HR> tag will be added to the HTML source for
this page.



The image file will be converted from its currently file format to a .JPG file (.JPEG on UNIX and Mac), one of the 
two image file types supported by most browsers. Choose GIF above to convert the image to a .GIF file, the other 
image file type supported by most browsers.



Choose this option to make the control a standard list box.





Choose this option if you would prefer no background for this style.



Choose this option to apply the line picture style (specified in Style view) to the selected rule.





Choose this option to create an internal data object. Select a name, enter comments and create data fields below 
(also see help on each individual item).











Choose this option to include a data object sourced with external data. Click on the Source button to open the 
Data Source Type dialog box to select your external data source type (also see help for that dialog box).



The data field will consist of images.    If you are creating this data object internally, you may select images by 
double-clicking on the empty data field after it is placed on a stacked data page.





Choose this option to stage or publish your site on a remote host or server.    Click the Configure button to 
configure settings for staging or publishing remotely.







Check this box to have the spaces in the names of your pages replaced with underscores when generated as 
HTML files.    For example, a page named My Page when generated as HTML would become My_Page.htm (or 
My_Page.html, depending on your choice of extension above); only the name of the HTML file NetObjects Fusion 
generates is changed, not the title of the page itself.



Enter the name for a field within this data object.    Choose from the options below to determine the type of data 
field (see help on individual options below).



Text will be aligned to the right margin of the style element.





Check this option if you would like to offset your background image the number of pixels specified in the Left and 
Top fields on the right. Since most browsers (such as Netscape Navigator or Microsoft Internet Explorer) add a 
small gutter on the top and left margins, you may find that text will not align with your background image perfectly. 
Offsetting your background image will allow you compensate for this gutter problem.











This list displays the data fields (of the chosen data object) which will be added to the current data list.    The 
checkboxes to the left of each field indicate whether or not this field will be included in the data list.    You may 
reorder their positions within the data list with the up and down arrow buttons on the lower right (the topmost field 
will be displayed in the leftmost column, and so forth).



Displays the name of the current site (if creating a new site, enter its name here).





Select an AutoSite or Page template from this list to base your new site on.



Templates.    Offers two different types of templates to give you a head start with building your site.
AutoSites are fully structured sites with suggested content and navigation elements. You can open them as new 
sites or insert them into other sites.
Page Templates are pre-built pages with suggested content. You can open them as new sites or insert them into 
other sites.





Choose the data field on which this data list will be sorted from this dropdown list. This option is available only 
when a data object is accessed by the data list.











Lets you type in an HTML alternate tag for the selected element. This text—generally a short description of the 
element—appears in place of the element in text-only web browsers or browsers in which graphics (or other 
features) are unsupported or have been turned off.



Enter the relevant text in this edit box.



Indicates that work on the page is complete.



Style Gallery.    Lists the SiteStyles that can be applied to your site and displays the various elements that make 
up the style. To edit a style's element, click the Elements button or double-click the style name.



Lets you apply a solid color background to the selected table.



Removes any solid color background from the selected table.



Lets you enter the margin, in points, between cell contents and cell container edges.



Lets you enter the margin, in points, between cells within the table or data list and its outside borders.











Enter the number of columns for your table here.



Enter the number of columns for your table here.







Enter or select the number of rows for your table here.







Choose this option to reapply the formatting of the chosen style to the active paragraph.    The formatting for the 
entire paragraph or text block (not just the current selection) will be replaced with the formatting for the style 
chosen.    Redefining the style, the alternate option, not reapplying the style, is the default option.



Choose this option to redefine the chosen style using the current text selection as an example.    The formatting of 
the chosen style will be replaced with the formatting of the text selection.    This is the default option when 
reapplying paragraph styles.



Applies bold formatting to the selected text.



Lets you choose a bullet style for the selected paragraph.







Click this button to open a color selection dialog and choose a new color for the selected text. The new color 
appears in the swatch next to the button.





Click this button to apply the color shown in the swatch to the selected text. To change the currently defined color, 
click the Color button.





Applies the default site color to the selected text.





Lists available fonts you can apply to the selected text. Site Style is the default font.    



Applies a solid color background to the selected text container. The color that will be applied is shown in the 
swatch next to the button. To change the color, click the Color button.



Choose a style for the selected paragraph. If you choose a style from this list, the style overrides any previously 
assigned font or size settings. You can also choose Add... from the list to add a new style based on any font or size
settings you apply.



Inserts the selected symbol above into the text block at the insertion point.











Check this box if you want to add text to the selected picture or graphic object container.











Displays the paragraph style to be reapplied or redefined. The options below determine whether this style or the 
paragraph itself will be modified. Redefining the style using the selection as an example is the default choice (see 
help for each option below).



Displays the paragraph style to be reapplied or redefined. The options below determine whether this style or the 
paragraph itself will be modified. Redefining the style using the selection as an example is the default choice (see 
help for each option below).





Removes any solid color background in the selected text container. 









Text will be aligned to the top of the style element.



Site view. This is the Site view where you build, organize and manage the structure of your site. You can drag 
pages and sections to new locations in your site, and NetObjects Fusion updates the page links automatically.



















Enter the URL (Internet address) to be linked to the selected object.



Vertically aligns the selected picture to the bottom of its bounding box, when the bounding box is sized differently 
from the picture.



Vertically aligns the selected picture to the center of its bounding box, when the bounding box is sized differently 
from the picture.



Vertically aligns the selected picture to the center of its bounding box, when the bounding box is sized differently 
from the picture.









Displays the number of paragraphs in the current page.





 When this box is checked (it's checked by default), a visible border is added to all elements placed on the page. 
To remove the borders, clear the checkbox.



Select this button if the currently selected page is to be excluded from the published site.



Enter or modify the Author Name, which is added to the HTML source. 



This text field displays the module (usually an .OCX file) which the selected ActiveX control uses for 
implementation.



Checking this option will place the filename listed in the above text field into the Codebase field in the ActiveX 
properties tab. (also see help for the text field above).



HIDC_DOFILE



Enter an HTML tag or tags to be inserted into current cursor position within the selected text block.



HIDC_SOLINK



HIDC_DOIMAGE



HIDC_DOLINK



Enter the number of pixels to move your background image to the left.



Enter the number of pixels to move your background image toward the top.



Enter the number of pixels to move your background image toward the top.



Lets you offset your background image. Most browsers (such as Netscape Navigator or Microsoft Internet 
Explorer) add a small gutter to the top and left edges of their windows. Offsetting your background images will 
allow you to compensate by moving the image to the left and toward the top.



Select the protocol to use to publish your site. Currently FTP (the protocol most often used for uploading files) is 
the only available protocol.



Click here to configure settings for remote staging.    Opens the Remote dialog box, where settings may be entered
or modified.



Enter the text you would like to be inserted into the published HTML page before the selected element. Click the 
Insert button to insert a text or HTML file in this edit box.    Click OK to confirm the insertion, Cancel to exit this 
dialog without inserting or changing the script.



Displays the name used by this name-value pair.    Enter a name here if creating a new name-value pair.    



The data field will consist of formatted text, which includes font styles, paragraph and other formatting attributes.



The data field will consist of simple text, without formatting.



Choose this option to go to the page which begins with the characters entered above. A list of all pages which 
match the search characters will be displayed.



Choose this option to go to the page which ends with the characters entered above. A list of all pages which match
the search characters will be displayed.



Choose this option to go to the page which contains the characters entered above. A list of all pages which match 
the search characters will be displayed.



Lets you preview the entire site when the Preview button is pressed. You may selectively preview the current page 
(and not the entire site) by holding down Ctrl while pressing the Preview button.    All links to other pages in your 
site will be disabled when previewing just the current page.



Check this option to preview the active or current page, and not the entire site, when the Preview button is 
pressed.    If this option is not checked, you may selectively preview an active page (and not the entire site) by 
holding down Ctrl while pressing the Preview button.



Enter the name or partial name of the page you wish to go to. Use the options below to choose whether to search 
for a page which begins with, contains, or ends with the text entered here. A list of all pages which match the 
search characters will be displayed.



Enter the relevant text in this edit box.



Folder in which the primary pages of your site will be stored. You can use any local or network path. 



Click here to configure settings for remote publishing.    Opens the Remote dialog box, where settings may be 
entered or modified.



Enter the number of pixels to move your background image to the left.



Displays the number of pages in your site.



Enter the text you would like to be inserted into the published HTML page within the tag associated with the 
selected element. The text inside the element is placed just before the tag’s closing angle bracket. For example, if 
you’ve placed the picture “airplane.jpg” on your page and added the text ‘lowsrc=”airplane_low.jpg”’, the HTML 
source will read <IMG SRC=”airplane.jpg” lowsrc=”airplane_low.jpg”>. Click the Insert button to insert a text or 
HTML file in this edit box. Click OK to confirm the insertion, Cancel to exit this dialog box without inserting the 
script.



Lets you offset your background image. Most browsers (such as Netscape Navigator or Microsoft Internet 
Explorer) add a small gutter to the top and left edges of their windows. Offsetting your background images will 
allow you to compensate by moving the image to the left and toward the top.



Displays the file name of the selected Java applet, Shockwave or other plug-in file.



Displays the Page Type for the selected page, either Normal or Stacked Page (data pages used by a data list).



Shows the color of the currently selected page icon. To change the color, click the Color button.



Displays the current background color of the selected data list or table. To change the color, click the Color button.



Shows the color of the currently selected page icon. To change the color, click the Color button.



Displays the name of the currently selected proportional font used throughout your site.



Displays the name of the currently selected monospace font in use throughout your site.



Displays the file name represented by the selected element.



Displays the color that will be applied to the selected line or element border. To change the color, click the Color 
button.



Displays the color that will be applied to the selected line or element border. To change the color, click the Color 
button.



Shows the current fill color for the selected graphic element. To change the color, click the Color button.



Shows the current fill color for the selected graphic element. To change the color, click the Color button.



Displays the file name of the selected Java applet, Shockwave or other plug-in file.



Displays the name of the current site (if creating a new site, enter its name here).



Shows the date and time the current site was created.



Shows the date and time the current site was last changed.



Displays the number of pages in your site.



Displays the current picture used for the banner in this style.    Click on the Browse button to select a new picture.



Displays the Font currently selected for this style element.



Displays the current picture used for regular or non-highlighted buttons in this style. Click on the Browse button to 
modify this selection.



Displays the current picture used for highlighted buttons in this style. Click on the Browse button to modify this 
selection.



Displays the color that will be applied to the selected text if you choose the color option next to the swatch. To 
change the color, click the Color button.



Shows the color that will be applied to the selected text container background if you choose the background color 
option. To change the color, click the Color button.



When a style is selected, you can view its elements in the window on the right. Double-clicking a style or clicking 
the Elements button in the secondary control bar will open the Elements view, where you may edit the style's 
elements.



When an element is selected, you can edit it by double-clicking the list item or clicking the Edit button in the 
secondary control bar.    See help for individual controls within each dialog box for further information.



Files. Shows you a list of files (such as pictures, audio, video, external HTML documents, Java applets, etc.) that 
are associated with your site. You can use the list to manage these files and their associations.
Links. Shows you a list of page, smart, and external links that are associated with your site, as well as the page or
pages on which each link appears.
Data Objects. Shows you a list of data objects that are associated with your site. Data objects define data-based 
information from either internal or external sources You can use the list to remove the data object from your site or 
edit the data object definition.
Variables. Shows you a list of User defined variables that are used within your site, as well as the page or pages 
on which each variable appears.



Enter or modify the name for this link. This name, used in Assets view, is an internal reference and is not added to 
HTML generated when your site is staged or published.



Choose this option to enable the Snap to Grid feature. All elements placed on a page will snap to the grid.    Grid 
settings are found in the View properties tab, in Page view.



HIDC_EDIT1_VALUE



HIDC_ABOUTBOX



HIDC_CUT



HIDC_COPY



Select a tail style to use for the selected line. You may choose a Point, Arrow, Diamond, Circle or Square.



HIDC_PASTE



Select a head style to use for the selected line. You may choose a Point, Arrow, Diamond, Circle or Square.



HIDC_UNDO



Check this box to have the line head and tail share the same style.



HIDC_LOOKUP



Check this box to have the line head and tail share the same color.



HIDC_COMMENT_TYPE



Enter or use the spin buttons to adjust the line width value from 1 to 100.    



Standard Cut, Copy, Paste and Undo buttons.    Use these to easily cut, copy and paste text or undo actions within 
this dialog box.



Enter or use the spin buttons to adjust the line width value from 1 to 100.



HIDC_FUNC_NAME



HIDC_LIST1



HIDC_LIST2



Displays a list of installed NetObjects Fusion Components.    To add a Component to this list, click on the Add… 
button below.



Check this box to outline the head and tail with the line color.



HIDC_EDITBODY



HIDC_FILESASSETS



HIDC_LISTFOLDERS



Select the type of variable to insert at the cursor position into the text block.    Select Date & Time to insert date or 
time variables (click the Date Format… button to choose from many date and time formats), or Site & General to 
insert site information and other variable.    These fields will update when you switch from view to view, preview or 
publish.    Select User defined to choose from text variables you have created (click the New… button to define a 
new variable).



Displays the name of the current MasterBorder. You may change this name at any time, which will update 
throughout your site.    To create a new MasterBorder, select the New button on the Layout properties palette, 
select the MasterBorder, and change its name and settings from this property palette.



HIDC_LISTASSETS



Displays all available variables for the field type chosen above.    If a Date & Time field is selected, click the Date 
Format… button to choose a date and time format.    If User defined is chosen, choose from the list of defined 
variables, or click the New… button to define a new one.



The value for the currently selected variable is displayed here.    The values are displayed only and are not 
editable.



HIDC_FILEPATHLABEL



Click on this button to choose a date format for the currently selected Date & Time field. Opens the Date Format 
dialog box, where many date and time formats are available.



HIDC_FILEPATH



HIDC_SITE_CUSTOM_ADD



HIDC_SITE_CUSTOM_DELETE



HIDC_EDIT_TAGNAME



HIDC_SITE_CUSTOM_NAME



Opens the New Anchor dialog box.    Click this button to create (or remove) an anchor for the selected element.    
To link the selected element to an already defined anchor click the Link… button and choose an anchor from the 
Internal Link tab.



Select this option to create an internal link to the current page. If desired, select an anchor from the Select Anchor 
dropdown list below to create a link to an anchor on the current page.



Click this icon to include a frame for the left side of the current MasterBorder.    The order of frames chosen 
(displayed in parentheses below) will determine whether a frame spans the height of the MasterBorder margin or 
ends at another frame’s edge.



HIDC_RADIO_CENTER



When this option is selected, a background grid is displayed in Page view.    Set the grid width and height below in 
terms of the current unit of measurement (see above).    Check the snap to grid/guides box below to have 
positioned elements snap to the grid.



When this option is selected, guides are displayed in Page view.    By default, one horizontal and vertical guide will 
appear on your screen.    Drag to reposition a guide, or hold down Ctrl and drag from a guide to create a new 
guide. Check the snap to grid/guides box below to have positioned elements snap to your guides.



HIDC_SITE_CUSTMO_LIST



Check this box to replace the current layout with an external HTML file.      Locate an external HTML file with the 
standard Open dialog box which appears when this option is selected.    The selected HTML file will be published 
in place of the current internal page layout.    No changes are made to the external HTML file.    To edit the external 
HTML file (with the editor specified in Edit | General Preferences), double-click anywhere in the grayed-out page 
view.    You may toggle between the internal layout (which is not lost) and the selected external HTML file.



HIDC_NEWASSETNAME



HIDC_USEANCHOR



Click this icon to include a frame for the right side of the current MasterBorder.    The order of frames chosen 
(displayed in parentheses below) will determine whether a frame spans the height of the MasterBorder margin or 
ends at another frame’s edge.



HIDC_FRAME_BORDER



HIDC_PICTURE_TEXT_ALIGN



The value for the currently selected variable is displayed here.    The values are displayed only and are not 
editable.



HIDC_RADIO_LEFT



HIDC_FINDPAGE



Displays the name of all pages in the current site. Enter a full or partial name of the desired page in the edit box 
above to jump to the desired page in this list box.



Click this icon to include a frame for the top of the current MasterBorder.    The order of frames chosen (displayed 
in parentheses below) will determine whether a frame spans the length of the MasterBorder margin or ends at 
another frame’s edge.



Check this box to allow users to resize the current frame from within their browser window.    If unchecked, the 
frame will be set to its current fixed height and width.



HIDC_ORIENTATION_SLIDER



Choose a date and/or time format to use for the current variable from the many formats below.



HIDC_ANCHORNAME



Displays a list of anchors defined for the page selected above.    Select an anchor from this dropdown list to create 
or modify the internal link to an anchor within the selected page.



Click this icon to include a frame for the bottom of the current MasterBorder.    The order of frames chosen 
(displayed in parentheses below) will determine whether a frame spans the length of the MasterBorder margin or 
ends at another frame’s edge.



HIDC_FRAME_BORDERSZ



Displays the current level of text rotation in degrees.    Use the slider control on the left to adjust the number of 
degrees the text will be rotated.    If the Right angles check box below is checked, this number will be constrained 
to 90 degree increments.



HIDC_RADIO_RIGHT



HIDC_PAGENAME_INTERNALLINK



Displays a list of anchors defined for the current page.    Select a new anchor from this list if changing the currently 
selected anchor.



HIDC_FRAME_BORDERSZ_SPIN



HIDC_STATIC_EXAMPLE



Select this option to create an internal link to a page within the current site. Enter a full or partial name of the 
desired page in the edit box (on the right) to jump to the desired page in the list box below.



Displays the current frame's name.    The default names are Left Frame, Right Frame, Top Frame or Bottom 
Frame.    You may enter a new name for the current frame in this edit box.    NetObjects Fusion uses this name 
when generating the HTML source for your site.



If this box is checked, text rotation will be constrained to 90 degree increments.    The current level of text rotation 
is displayed above.    Use the slider control on the left to adjust the degree of text rotation.



HIDC_ORIENTATION_SLIDER2



Click here to make the current frame scrollable.    Regardless of the frame's contents, site visitors will see scroll 
bars for this frame in their browser window.



HIDC_CHECK_RA2



Click here to make the current frame size not scrollable. Regardless of the frame's contents, site visitors will never 
see scroll bars for this frame in their browser window.



Click here to have browsers automatic determine whether to include scroll bars or not for the current frame.    If the
contents of the frame fits within the frame size, no scroll bars will be displayed.    If the contents extend beyond the 
frame size (such as when users resize their browser window) scroll bars will be displayed.



Enter the number of the FTP port you would like to publish or stage to (the default is 21).    In most cases, you will 
not need to modify this field. 



Check this box to enable the generation of comments in the HTML source.    NetObjects Fusion adds various 
comments to the HTML to help describe the generated source.



Check/uncheck this box to enable/disable the generation of a data (.MCF) file for Apple’s HotSauce (previously 
known as Project X) site map format.



HIDC_ARCHIVE



Click on this button to define a new text variable when the User defined type is selected above. Opens the New 
Variable dialog box, where you name and assign a value to a new variable.



HIDC_ARCHIVE_FORMAT



Enter a name for the new User defined variable here.



Enter a value for the new User defined variable here.



Enter an indent level for this style in the edit box, or use the spin buttons to adjust the level.    Note: each indent 
level increment of 1.00 is equal to 40 pixels.



Displays the name of the currently selected anchor.    If creating a new anchor, enter its name here.



Enter the number of directory levels you wish to limit this import to, or use the spin buttons to adjust the value.



Select the text alignment (Left, Center or Right) to be used for this style.



Click on this button to remove the currently selected anchor from the page.



Enter the maximum number of pages to import from the chosen site in this edit box, or use the spin buttons to 
adjust the value.



HIDC_SLURPHOMEPAGE



Lets you view or change the width of the top margin in terms of the current unit of measurement. You can change 
the margin size by typing a new number directly into this field or clicking the spin buttons to change the value in 
increments of one unit.



HIDC_SLURPMAXTIMEOUT



HIDC_TOP_MARGIN_SPIN



Click the up or down arrows to change the top margin width in increments of one unit.



HIDC_SLURPLOCALPATH



Lets you view or change the width of the bottom margin in terms of the current unit of measurement. You can 
change the margin size by typing a new number directly into this field or clicking the spin buttons to change the 
value in increments of one unit.



Click the up or down arrows to change the bottom margin width in increments of one unit.



Select this option to have the imported site converted to NetObjects Fusion format.    When converted all text, links,
pictures and other elements within pages are brought into Page view, and can be modified as any NetObjects 
Fusion page layout.    When this box is unchecked, each page is considered an external HTML file, which can only 
be edited with the HTML editor specified in Edit | Preferences.



HIDC_SLURPLOCALPATH2



Displays the currently selected unit of measurement used in determining margin size. You can change the unit 
used by clicking the View tab and choosing another Measurement Unit from the list.



Enter the local path and filename of the page to be imported as the root or Home page.    The standard filename is 
index.html (browsers look for and automatically open files of this name when pointed to a folder).



Displays the currently selected unit of measurement used in determining margin size. You can change the unit 
used by clicking the View tab and choosing another Measurement Unit from the list.



Enter the domain name used by the local site you wish to import.    NetObjects Fusion will define imported assets 
as internal or external based on the domain name entered here. For example, links which include this domain 
name in their URL will be considered internal.



HIDC_TEXT_PD_BROWSE



HIDC_SLURPIMPORTOPTIONS



Click on this button to open the Text Settings dialog box, where you may modify the text settings for the current 
style element.



Opens the Custom Names dialog box, where you can customize the title, button name, banner name and file 
extension for the current page.



HIDC_DONTSHOW



HIDC_TEXT_SELECTITEMS



HIDC_SLURPDIRBROWSE



Enter the correct file or folder name in this edit box.    Click on the Browse button to open a standard Open dialog 
box.



Click here open the Paragraph Style dialog box, where you select or modify the current style’s attributes.    You 
may also select and format text (using the options on this property palette) and reselect the style in the dropdown 
list.    The Reapply Style dialog box will open, which will allow you to redefine the style with the character formatting
of the selected text.



Choose an application to use as an HTML editor, which will be invoked for pages which you associate with 
external HTML files.    Enter the filename and path here, or click on the Browse… button to open a standard file 
Open dialog box to browse for a program file (.exe).



Displays the current display setting for the selected nav bar.    Click on the Set… button to open the Nav Bar 
Display dialog box and adjust the current display setting.



Click on this button to open the Text Settings dialog box, where you may modify the text settings for the current 
style element.



Click here to include a background sound for the current page.    The Background Sound dialog box will open, 
where you select a sound file.    (To modify your selection at a later point, click on the Sound… button.) 



Check this box to limit the number of pages NetObjects Fusion will attempt to import from the chosen site.    Enter 
the maximum number of pages in the edit box, or use the spin buttons to adjust the value.



Displays the missing file or folder name which is no longer properly associated to its file asset.



Open a standard file Open dialog box where you may browse for a program file (.exe) to use as an HTML editor, 
which will be invoked for pages which you associate with external HTML files.



Click here to create a new Paragraph Style. The New Paragraph Style dialog box opens, where you name your 
new style. To define its attributes, either click on the Edit button (which opens a separate Paragraph Style dialog 
box) or select and format text (using the options on this property palette) and reselect the style in the dropdown list
on the left.    The Reapply Style dialog box will open, which will allow you to redefine the style with the character 
formatting of the selected text.



Enter a name for your form here.    The form name is used primarily for advanced scripting.



Select this option to limit the depth of directory levels NetObjects Fusion will import from the chosen site.    Enter 
the number of levels directly into the edit box or use the spin buttons to adjust the value.



Opens a standard Windows file Open dialog box, where you may browse for files or folders.



Check this box to resize your layout margins when objects are dragged beyond the edges of the current page 
layout margins (large objects when first positioned will automatically resize margins).    This option is disabled by 
default.



HIDC_SLURP_ANMCONTROL



Select this option to use the current SiteStyle for primary or secondary buttons used for this nav bar.    Select a 
button style from the Buttons group above.    This option has no effect on text buttons.



HIDC_SLURPIMPORT_REMOTE



Click on this button to skip this file or folder and continue verifying file assets.



Enter a default page or layout width, in pixels, to be used throughout the current site, or use the spin buttons to 
adjust.



Select this option to choose a style different from the selected Site Style for use only with the selected banner.    
Select a different style to use for the selected banner from the dropdown list.    



Enter the URL address of the remote site you wish to import.



HIDC_SLURPIMPORT_LOCAL



Lists all found missing file or sub-folders which were previously found in the missing folder.



Opens the Background Sound dialog box, where you enter a sound file for the current page.



Select a style to use for the selected banner.    This affects the current banner only.



Enter the path and filename of a sound file to use as the background sound for this page (.au, .wav and .mid files 
are supported).    Click on the Browse button to open a standard file Open dialog box to browse for sound files.



Opens the Nav Bar Display dialog box, where you choose which levels and pages the selected navigation bar will 
display.    See help on individual controls within the Nav Bar Display dialog box for further help.



HIDC_EDIT_BG_LOOP



Enter HTML or other script text to be inserted inside the Head tag (if Layout Script), or before the selected 
element's definition tag (if Element Script).    Click on the Insert button to open a standard file Open dialog box to 
insert a text file into this edit box.



Click on the spin buttons to the right to rotate the selected picture in 90 degrees increments.



Check this box to have the selected background sound repeat continuously when site visitors browse to this page.



Enter the URL address of the remote site you wish to import.



HIDC_COMMENT1_VALUE



Displays the font chosen.    To change the current font click on the Set… button to open a standard Font dialog 
box.



Opens a standard file Open dialog box to browse for sound files (.au, .wav and .mid files are supported), or directly
enter the path and filename of a sound file to use as the background sound for this page in the edit box. 



HIDC_COMMENT3_VALUE



Click this button to flip the selected banner 180 degrees.    



HIDC_STATIC_FONT2



HIDC_STATIC_COLOR_WELL



Enter HTML or other script text to be inserted inside the Body tag (if Layout Script), or inside the selected 
element's definition tag (if Element Script).    Click on the Insert button to open a standard file Open dialog box to 
insert a text file into this edit box.



HIDC_RCOMBO



Click this button to add all fields listed above to this data list.



HIDC_COMMENT2_VALUE



Click on this button to add a new Component to the list of available components.    Opens a standard file Open 
dialog box where you can select a .NFX or NetObjects Fusion Component file. 



Enter HTML or other script text to be inserted at the beginning of, but not inside, the Body tag (if Layout Script), or 
after the selected element's definition tag (if Element Script).    Click on the Insert button to open a standard file 
Open dialog box to insert a text file into this edit box.



Displays the color chosen for the text.



Click on the spin buttons to the right to rotate the selected picture in 90 degrees increments.



HIDC_SERVER_LIST



HIDC_CLEAR_FILTER



Opens the Insert Variable dialog box, where you may enter Date and Time, Site or User-defined variables into the 
selected edit box (where the cursor is currently located).    See help within the dialog box for further information.



Displays a number indicating the order of frames selected with the icons above.    This order determines which 
frames span the height or width of the MasterBorder margin or end at another frame’s edge.



Displays a number indicating the order of frames selected with the icons above.    This order determines which 
frames span the height or width of the MasterBorder margin or end at another frame’s edge.



Displays a number indicating the order of frames selected with the icons above.    This order determines which 
frames span the height or width of the MasterBorder margin or end at another frame’s edge.



Displays a number indicating the order of frames selected with the icons above.    This order determines which 
frames span the height or width of the MasterBorder margin or end at another frame’s edge.



HIDC_TEXTFIELD_URL



HIDC_TEXTFIELD_TEXT



HIDC_TEXTFIELD_HTML



When this option is checked, HTML frame borders will be generated and displayed in web browsers.



HIDC_TEXTFIELD_DBOPTIONS



HIDC_RADIO_NOCONVERT



HIDC_INPUTPROMPT



HIDC_FILEASSETTAB



Opens a standard Windows file Open dialog box to browse for the Home page of your local site or section.



Click to cancel your modification to the ActiveX or NetObjects Component property highlighted below.



HIDC_HTMLTAG



Click this button to open an applicable dialog box (such as a standard file Open or Color dialog box) to edit the 
selected parameter.



Select this option to create a new site based on a remote web site.    The Set Remote Import dialog box will open if
you choose to create a new site in this manner.    See help for controls within that dialog box.



Displays the total Width and Height for the current page, which includes the current layout size and MasterBorder 
size, in terms of the selected unit of measurement.



Use these spin buttons to adjust the the number of directory levels you wish to limit this import to.



Select from a dropdown list of available Java applet (.class) files.    To add or delete class files from this list click on
the List… button, which opens the Java Applet Files dialog box.    This dialog box allows you to manage a list of 
Java applet files you plan to use throughout your site. 



HIDR_LAYOUT_MENU



Click the up or down arrows to change the left margin height in increments of one unit.



Displays the currently selected unit of measurement used in determining margin size. You can change the unit 
used by clicking the View tab and choosing another Measurement Unit from the list.



Lets you view or change the height of the left margin in terms of the current unit of measurement. You can change 
the margin size by typing a new number directly into this field or clicking the spin buttons to change the value in 
increments of one unit.



Enter a default page or layout height, in pixels, to be used throughout the current site, or use the spin buttons to 
adjust.



Enter a custom title for the current or selected page.    Site visitors will see this title in the titlebar of their browser 
when viewing this page. This overrides the default page title, which takes from the page name displayed in Page 
properties (which is used as the HTML filename).



Displays the total Width and Height for the current page, which includes the current layout size and MasterBorder 
size, in terms of the selected unit of measurement.



Select this option to create a new site based on a local copy of a pre-existing web site.    The Set Local Import 
dialog box will open if you choose to create a new site in this manner.    See help for controls within that dialog box.



HIDC_BUTTON3



HIDC_BUTTON4



HIDR_SITESLURP_FILECOPY_AVI



Click on this button to delete a Java applet file from the list.



Applies strikeout formatting to the selected text.



Check/uncheck this box to enable/disable the generation of a data file for NetObjects Fusion’s Sitemapper 
component.



HIDC_INSERT_SCRIPT2



Click this button to open the Text in Element Settings dialog box, where you can modify various attributes of the 
text you wish to place on the selected element.    See help on individual controls within the Text in Element Settings
dialog box.



HIDC_PICT_TEXT_ORIENTATION



HIDC_EDIT4



HIDC_EDIT5



Enter value(s) here.



Opens a standard Color dialog box, where you can choose a color for the line's tail. 



Enter or edit the highlighted ActiveX control or NetObjects Fusion Component property in this edit box.    Click the 
check icon to save your changes, or the X icon to cancel the adjustment.    (For editing certain properties, such as 
Color, double-clicking on the property will open an applicable standard Windows dialog box.)    



Displays the currently selected unit of measurement used in determining page size. You can change the unit used 
by clicking the View tab and choosing another Measurement Unit from the list.



Displays the current line head color.    Click on the Color button to change this color.



Displays the current line tail color.    Click on the Color button to change this color.



Displays the current line color.    Click on the Color button to change this color.



Displays the currently selected unit of measurement used in determining page height and width. You can change 
the unit used by clicking the View tab and choosing another Measurement Unit from the dropdown list.



HIDC_SLURPTIMEOUT_CHECK



HIDC_TEXT_LOCK2



HIDC_FIELD_VAL



Enter a custom banner title for the current or selected page.    This overrides the default banner title, which takes 
from the page name displayed in Page properties.    This applies to all banners, whether placed in the 
MasterBorder or in the page layout.



HIDC_STATIC_TEXT_BOX2



Enter a custom nav bar button name for the current or selected page.    This overrides the default nav bar button 
name, which takes from the page name displayed in Page properties.    This custom name will be used in all nav 
bar buttons throughout your site.



HIDC_SITE_CUSTOM_VALUE



HIDC_SLURPCASEURLS_CHECK



Click the up or down arrows to change the right margin height in increments of one unit.



Displays the currently selected unit of measurement used in determining margin size. You can change the unit 
used by clicking the View tab and choosing another Measurement Unit from the list.



HIDC_ANCHOR



HIDC_CURSOR2



Shows the available properties for the current ActiveX control or NetObjects Component.    Depending on which 
type of property is selected, you will either see an edit box or drop-down combo box at top, and (when applicable) 
a set of spin buttons or a square button to the right.    Enter values directly into the edit box, or choose a value from
the drop-down list. The spin buttons allow you to adjust numerical values, while the square button will open an 
applicable standard dialog box for the selected property.    When editing a property such as Color, for example, a 
standard Windows Color dialog box will open when the square button is clicked.    Click the checkmark icon to save
your changes, or the X icon to cancel the current adjustment. 



Use this slider to to adjust the degree of text rotation.    In Page view, the text is re-oriented directly on-screen.    
Choose undo from the Edit menu to undo any changes made in this dialog box. The current level of text rotation is 
displayed to the right. If the Right angles check box is checked, text rotation will be constrained to 90 degree 
increments. 



HIDC_TEXTFIELD_HTMLFILE



Displays the current line color.    Click on the Color... button to change this color.



Lets you view or change the height of the right margin in terms of the current unit of measurement. You can 
change the margin size by typing a new number directly into this field or clicking the spin buttons to change the 
value in increments of one unit.



Displays the current background sound file you have selected for this page.



Enter a custom file extension to use for the current or selected page.    This overrides the default extension name, 
which is set in Settings for Stage or Publish, in Publish view.    This custom extension will apply to the current 
page's filename only.



When this option is selected, neither the grid nor guides are displayed in Page view.



Displays the external HTML file you have chosen to replace the current page layout.



Use these spin buttons to adjust the indent level for this style, or enter a number directly into the edit box.    Note: 
each indent level increment of 1.00 is equal to 40 pixels.



Use these spin buttons to adjust the maximum number of pages to import from the chosen site or directly enter a 
value into the edit box.



HIDC_SPIN



Enter a default page or layout width, in pixels, to be used throughout the current site, or use the spin buttons to 
adjust.



Opens a standard Color dialog box, where you can choose a color for the selected line. 



HIDC_PICTURE_TEXT_CENTER



Opens a standard file Open dialog box, where you select an HTML file to replace the current page layout.



HIDC_PICTURE_TEXT_RIGHT



Displays the current line head color.    Click on the Color button to change this color.



Applies subscript formatting to the selected text.



Enter or modify the text you wish to place on the current selected object or element.    Modify settings for the text in
element with the options below.



Opens a standard Color dialog box, where you can choose a color for the line head.



Applies superscript formatting to the selected text.



Displays the current line tail color.    Click on the Color button to change this color.



HIDC_SPIN_BG_LOOP



Enter a default page or layout height, in pixels, to be used throughout the current site, or use the spin buttons to 
adjust.



Click on these spin buttons to rotate the selected picture in 90 degrees increments.



Displays the selected button text.



Check this box to enable the snap to objects feature.      When an element or object is positioned near enough to 
another onscreen, it will “snap” to the adjacent object.



Select this option to create a new site from scratch.    A blank site with one page will open in Site view.



Select this option to create a new site based on a NetObjects Fusion AutoSite template.    Choose an AutoSite 
template from the dropdown list (on the right).



Opens a standard Windows file Open dialog box to let you browse for NetObjects Fusion template (.nft) files.    
Choose from predefined templates or from .nft files you've created (Page templates, for example, can be found in 
the NetObjects Fusion\Templates\Pages folder). 



Displays the template path and filename you wish to base this new site on.    You may directly enter or modify the 
path and filename here.    Click on the Browse button to open a standard Windows file Open dialog box, which lets 
you browse for NetObjects Fusion template (.nft) files.    Choose from predefined templates or from .nft files you've 
created (Page templates, for example, can be found in the NetObjects Fusion\Templates\Pages folder). 



Select this option to create a new site based on a NetObjects Fusion template (.nft) file. Click on the Browse 
button (to the right) to open a standard Windows file Open dialog box, which lets you browse for template files, or 
directly enter the full path and name in the edit box.    Choose from predefined templates or from .nft files you've 
created (Page templates, for example, can be found in the NetObjects Fusion\Templates\Pages folder). 



Choose an AutoSite template from this list to create a new site based on a NetObjects Fusion AutoSite template.    
AutoSites templates displayed here are .nft (NetObjects Fusion template) files found in the NetObjects Fusion\
Templates\AutoSites folder.



Select this option to insert a section based on a NetObjects Fusion Page template into the current site as a child of
the selected page (in Site view).    Choose a Page template from the dropdown list on the right.    Page templates 
displayed here are .nft (NetObjects Fusion template) files found in the NetObjects Fusion\Templates\Pages folder.



Select this option to insert a section based on a NetObjects Fusion template (.nft) file into the current site as a 
child of the selected page (in Site view).    Click on the Browse button (to the right) to open a standard Windows file
Open dialog box, which lets you browse for template files or directly enter the full path and name in the edit box.    



Displays the path and filename of the template to be inserted into the current site.    You may directly enter or 
modify the path and filename here.    Click on the Browse button to open a standard Windows file Open dialog box,
which lets you browse for NetObjects Fusion template (.nft) files. 



Opens a standard Windows file Open dialog box to let you browse for NetObjects Fusion template (.nft) files. 



Choose a Page template from this list to create a new site based on a NetObjects Fusion Page template.    Page 
templates displayed here are .nft (NetObjects Fusion template) files found in the NetObjects Fusion\Templates\
Pages folder.



Select this option to insert a local copy of a pre-existing web site as a section into the current site (as a child of the 
selected page).    The Set Local Import dialog box will open if you choose to insert a section of this type.    See help
for controls within that dialog box.



Select this option to insert a remote web site as a section into the current site (as a child of the selected page).    
The Set Remote Import dialog box will open if you choose to insert a section of this type.    See help for controls 
within that dialog box.



Opens a standard Windows file Open dialog box, where you may browse for a picture file to use for this style's 
background.



Positions text horizontally to the left within the element.    Not to be confused with the Relative Alignment buttons 
(see help on Relative Alignment buttons for further information).



Positions text horizontally to the center within the element.    Not to be confused with the Relative Alignment 
buttons (see help on Relative Alignment buttons for further information).



Positions text horizontally to the right within the element.    Not to be confused with the Relative Alignment buttons 
(see help on Relative Alignment buttons for further information).



Positions text vertically to the top within the element.    Not to be confused with the Relative Alignment buttons (see
help on Relative Alignment buttons for further information).



Positions text vertically to the center within the element.    Not to be confused with the Relative Alignment buttons 
(see help on Relative Alignment buttons for further information).



Positions text vertically to the bottom within the element.    Not to be confused with the Relative Alignment buttons 
(see help on Relative Alignment buttons for further information).



Check this option to have NetObjects Fusion always open in a maximized window.



Adjust the current value with these spin buttons.



Enter a value in pixels with which to inset the text within the current text block.



Displays a list of URLs used within the current site.    You may choose an external link from this list to use for the 
current object or text.



Choose an internet protocol type from the dropdown list to use for this external URL.    You may also type directly 
into this dropdown list/edit box. 



HIDC_EDIT_INLINE



HIDC_LOOKUP2



HIDC_LOOKUP1



Check this radio button to optimize NetObjects Fusion's HTML generation for Netscape browsers. Optimized 
WYSIWYG support displays your previewed or published site in Netscape as it appears within NetObjects Fusion.



Check this radio button to optimize NetObjects Fusion's HTML generation for Microsoft Internet Explorer.    
Optimized WYSIWYG support displays your previewed or published site in Internet Explorer as it appears within 
NetObjects Fusion.



Choose a language dictionary to use for spell checking from this dropdown list.



Check this option to disable the conversion of High ASCII characters to HTML character entities (also called 
escape sequences).    Especially useful for building non-English web sites using double-byte character sets.



Use these spin buttons to adjust the value in pixels with which to inset the text within the current text block.



Click here to leave the word in the Not found box unchanged.



Click here to open the Spell Check Options dialog box, where you specify the lanaguage and personal dictionary 
to use when checking spelling in NetObjects Fusion.



Words not found in the dictionary and personal dictionary file (selected in the Spell Check Options dialog box) are 
displayed here.    For more information, view help for each control within this dialog box.



Suggested spellings for the word not found are displayed here.    A suggested word spelling will appear in the 
Change to box.    Choose another word from the list of suggestions to replace the current entry in the Change to 
box.    For more information, view help for each control within this dialog box.



Displays the personal dictionary file in use.    Click the Browse button to locate a dictionary file (*.dic) or enter its 
path and name here.



Click here to change all instances of the word in the Not found box to the word in the Change to box.



Click here to leave all instances of the word in the Not found box unchanged during this spell check.



Click here to add the word in the Not found box to the personal dictionary selected in Spell Check Options.



Click here to change the word in the Not found box to the word in the Change to box.



Click here to display a list of proposed alternatives for the word in the Change to box.



Click on this button to open the Insert Variable dialog box where you may specify a Variable to be inserted into the 
raw HTML source of the active text block (at the insertion point), along with any other HTML tags or scripts entered
in this dialog.




